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1. Introduction 
Lantronix serial device servers provide the ability to communicate serial data across an Ethernet network.  

The SDSTX3110-124-LRT-B contains (2) 10/100Base Fast Ethernet ports that can be configured to one or 
multiple redundant servers. It has four (4) DB9M Serial Ports.  

Data transmission security is assured through HTTPS, SSH, and SSL data encryption on all three models.  
They come with COM port redirector software enabling communication of serial data to a virtual COM port on a 
server or can be used in pairs to provide serial tunneling across the Ethernet network. They are hardened devices 
designed to operate in the harshest environments. Enclosed in an IP30 enclosure and accepting input voltage of 
12 to 48 VDC, the device is certified to operate in temperatures of -40°C to +70°C. 

1.1 Product Numbers 
The SDS models are described below. 

Product # Description 

SDSTX3110-124-LRT-B Industrial 4 secure serial port to Ethernet device server with four (4) 
RS232/422/485 DB9 ports and (2) 10/100Base-TX RJ-45 ports. 

Optional Accessories  (sold separately) 

25130 Industrial DIN Rail Mounted Power Supply; Input: 85-264 VAC, 120-370 VDC. 
Output: 48VDC, 0.83A, 39.8 Watts. 

25135 Industrial DIN Rail Mounted Power Supply; Input: 85-264 VAC, 120-370 VDC. 
Output: 24VDC, 0.42A, 10 Watts. 

1.2 Features 
• Operating Modes: Virtual Com, Serial Tunnel, TCP Server, TCP Client, UDP 
• Redundant multiple host devices: 

o 5 host devices: Virtual COM, TCP Server, TCP Client mode 
o 4 IP ranges in UDP mode 

• Security: SSL data encryption; secured management by HTTPS and SSH: IP Access: IP Whitelist 
• Event Warning via Syslog, Email, SNMP trap  
• Configurable by Web interface, Windows utility (SDS-Manager), or SSH Console. 
• SDS-Manager-x64 for Windows Server 2003 and  2008, Windows XP, Windows 7, Windows 8 
• SDS-Manager 32 bit version for Windows Server 2003 and 2008, Windows XP,  Windows 7, Windows 8 

1.2.1 Hardware Features 
• DIN-rail and wall-mount  enabled 
• Redundant DC power inputs  
• IP Casing: IP-30 
• LOCATE LED 

1.2.2  Software Features 
• Supports five host devices including Virtual COM, TCP Server, TCP Client modes and four IP ranges 
• Supports application-based QoS management 
• NAT-pass through support for users to manage SDS through NAT router 
• Ensure high levels of security with SSL data encryption, HTTPS/SSH, IP access control and IP whitelist 
• Event warning by Syslog, Email, and SNMP trap 
• Configurable by Web Interface, SSH console, and Windows utility 

https://www.lantronix.com/
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1.3 Applications 
The figures below show typical SDS configurations (e.g., Multiple Host PCs, SSL Data Encryption, TCP 
Client/Server Modes, and NAT Router Pass-through). 

   

Multiple Host PCs 

 

  

SSL Data Encryption 

https://www.lantronix.com/


Lantronix              SDSTX3110-124-LRT-B User Guide 

33686 Rev. C https://www.lantronix.com/ 7 

 

TCP Client/Server Modes 

 

 

NAT Router Pass-through 
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1.4 Dimensions 

1.4.1 SDSTX3110-124-LRT-B Dimensions 

The SDSTX3110-124-LRT-B cabinet dimensions are provided below: 

• 66 (W) x 81 (D) x 95 (H) mm 
• 2-5/8 (W) x 3-1/4 (D) x 3-3/4 (H) inches 

 
 
 
  

https://www.lantronix.com/


Lantronix              SDSTX3110-124-LRT-B User Guide 

33686 Rev. C https://www.lantronix.com/ 9 

1.5 Pin Definitions 

1.5.1 DB9 Connector 
The SDSTX3110-12x-LRT-B serial port can be connected using a DB9 cable.  
The DB9 connector supports RS232 / RS422 / RS485 operation modes. 
The table below provides the DB9 connector pin assignments.  

Pin # RS-232 RS-422 RS-485 (4 wire) RS-485 (2 wire) 
1 DCD TX- TX- DATA- 
2 RXD TX+ TX+ DATA+ 
3 TXD RX+ RX+  
4 DTR RX- RX-  
5 GND GND GND  
6 DSR    
7 RTS    
8 CTS    
9 RI    

1.6 Packing List 
Carefully unpack the items near the final location. Save the packing materials for possible future use.  
Verify that you received the items below. Contact your sales representative if you have not received all the 
following items: 

□ One SDSTX3110-12x-LRT-B  
□ Two wall-mounted brackets or two DIN rail brackets 
□ One 5.5x2.0 DC Jack to 1 pair Cable, 200mm, Black, Female, D2C-2001 
□ One support Postcard  
□ One Accessory Kit with one Plastic Bag containing one 4-Pin Terminal Block, two or four I/O Dust Covers, 

and four or eight Screws. 
 

       

1.7 Optional Accessories 
These optional accessories can be ordered separately: 
□ 25130 Industrial DIN Rail Mount Power Supply  
□ 25135 Industrial DIN Rail Mount Power Supply 

 
See the Power Supply Specifications on page 83 for power supply details.  
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2. Hardware Overview  

2.1 Front Panel 

2.1.1 Ports and Connectors 
The Ethernet ports on the device use RJ45 connectors. 
 

Port Description 
Copper Ports 1 and 2 Two 10/100 Base-T(X) ports  (ETH 10/100M) 
Serial Ports S1 - S4 Four DB9 Serial Ports (SDSTX3110-124-LRT-B) 

Reset button Press the front panel Reset button to re-load all of the factory default settings 
(Hardware reset). 

 

2.1.2 Front Panel 

 

    SDSTX3110-124-LRT-B Front Panel 
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2.1.3  LED Descriptions 

LED Color Status Description 

PWR1/PWR2 Green On Power is ON and function is normal. 

PWR2/PWR2 Green Off Power is OFF. 

ETH1/ETH2 Green On Port is connected and running at 10 or 100Mbps. 

ETH1/ETH2 Green Off Port is not connected. 

Rx Red On Receiving serial data on the port below this LED. 

Tx Green On Transmitting serial data on the port below this LED.  

LOCATE Green On 

The front panel LOCATE LED can help you identify the intended 
SDS device. The LOCATE LED lights when activated. The 
LOCATE LED stays on until deactivated. To locate a specific SDS 
among many devices in a data center, use the SDS-Manager to 
light the SDS front panel LOCATE LED. 

2.2 Top Panel 
Below are the top panel components: 

1. Terminal blocks: PWR 1 PWR 2 for power connectors. 

2. Grounding screw hole (see section 3.4.1 Grounding on page 16). 

3. Wall Mount screw holes. 

 
 

SDSTX3110-124-LRT-B Top Panel 
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2.3 Back Panel 
Below are the back panel components with the pre-installed DIN-rail kit removed: 
 
 

 
 

Below is the back panel shown with the pre-installed DIN-rail kit: 

  

3. Hardware Installation 

3.1 DIN-Rail Installation 
A DIN-Rail kit is pre-installed to let you fasten the device to a DIN rail. The dimensions are provided below. 
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SDSTX3110-124-LRT-B Dimensions (in mm) 
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3.2 Wall Mounting 
The SDS can be fixed to the wall via the wall mount kit included in the package. The wall mount kit dimensions 
are provided below. 

 
 

To install the device on a panel or wall: 
1: Remove the Din-Rail clip by removing the three screws.  

 2: Use the screws included in the package to install the wall mount bracket. 
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3.3 Rack Mounting 
The SDS can be rack mounted using the procedure below. 

1. Install the provided L-shaped mounting brackets to the left and right sides of the device as shown below. 
2. With the front brackets oriented in the front of the rack, mount the device in the rack with the four rack-

mounting screws.  
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3.4 Wiring 

 

3.4.1 Grounding 
Grounding and wire routing help limit the effects of noise due to electromagnetic interference (EMI). Run the 
ground connection from the ground pin on the power module to the grounding surface prior to connecting devices. 

3.4.2 Redundant Power Inputs 
The device has two sets of DC power inputs on the 4-pin terminal block located on top of the device. Follow the 
steps below to wire the power input on the terminal block. 

1. Insert the Terminal Block connector into the keyed receptacle on the SDS. 
2. Insert the negative/positive wires into the V- and V+ terminals, respectively. 
3. To keep the wires from pulling loose, use a small flat-blade screwdriver to tighten the wire-clamp screws on 

the front of the terminal block connector.  

 
  

https://www.lantronix.com/


Lantronix              SDSTX3110-124-LRT-B User Guide 

33686 Rev. C https://www.lantronix.com/ 17 

3.5 Connection 

3.5.1  10/100BASE-T(X) Pin Assignments 
Based on the link type, the device can use CAT 3, 4, 5, or 5e UTP cables to connect to any other network devices 
(PCs, servers, switches, routers, or hubs). See the table below for cable specifications.  

With 10/100BASE-T(X) cables, pins 1 and 2 are used for transmitting data, and pins 3 and 6 are used for 
receiving data. Note that the + and - signs represent the polarity of the wires that make up each pair.  

Pin Number Assignment 
1 TD+ 
2 TD- 
3 RD+ 
4 Not used 
5 Not used 
6 RD- 
7 Not used 
8 Not used 

3.5.2  Cable Types and Specifications 

Cable Type Max. Length Connector 
10BASE-T CAT 3, 4, 5 100-ohm UTP 100 m (328 ft) RJ-45 
100BASE-TX CAT  5 100-ohm UTP UTP 100 m (328 ft) RJ-45 
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4. Management 
Management / configuration methods include: 

1. Web interface  
2. Windows utility (SDS-Manager) 

a) SDS-Manager-x64 for Windows Server 2003 & 2008, Windows XP, Windows 7, Windows 8. 
b) SDS-Manager 32 bit version for Windows Server 2003 & 2008, Windows XP, Windows 7, Windows 8. 

3. SSH Console connect to SDS Commander 

4.1 SDS-Manager 
SDS-Manager is a powerful Windows utility for SDS devices. SDS-Manager supports device discovery, device 
configuration, group setup, group firmware update, and monitoring. SDS-Manager lets you easily install and 
configure devices on the network. SDS-Manager requires 8881 Kb of disk space.  

Two versions of SDS Manager are available; one each to support to support 32-bit and 64-bit Windows systems. 

1. Determine which version you require. 
2. Download it from the Lantronix website: SDS Management Software zip file (e.g., filename  

SDS-Manager_x64_v1.5a_20160413.zip). 
3. Unzip the Zip file (e.g., SDS-Manager_x64_v1.5a_20160413.exe).  
4. Note the name and location of the executable file(s). Firmware file name is SDSTX3110-124-LRT-

B_20161221_1.4_uImage. SDS-Manager file names are SDS-Manager_x64_v1.5a.exe and SDS-
Manager_v1.5a_201601207.exe.  

4.1.1 Install the SDS-Manager 
Follow the steps below to install the SDS Manager.  

1. Select the folder for the SDS-Manager and click Start to run the setup program. The Destination Directory 
screen displays. 

 
2. Click the Start button to install in the default directory (C:\Program Files (x86)\SDS-Manager), or browse to and 
select a different location and then click the Start button.  When done the message Installation was completed 
successfully displays.  

   
3. Click the OK button. A dialog displays indicating The installation of SDS-Manager is finished.  

https://www.lantronix.com/
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4. Check either the Launch SDS-Manager Now checkbox or the Launch SDS-Manager Later checkbox. 

  

When you launch SDS-Manager, a confirmation message displays.  

  

5. Click Yes to restart your computer to complete the installation, or select No and restart it later.  

The SDS-Manager startup screen (Device List) displays: 
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4.1.2 SDS-Manager Overview 
SDS-Manager is an easy-to-use Windows utility for managing one or many Serial Device Servers. A Serial Device 
Server provides a transparent serial gateway to Ethernet without modifying existing COM port control programs.  

Major SDS Manager functions include Configuration: To configure device and serial ports; Monitor: To monitor 
device and port status; Setup Wizard: Quick start for general applications; IP Collection: Auto collect IP 
addresses of dynamic device IP setting; and System Log: System Log information for troubleshooting. 

Configuration: 
1. Use Broadcast to search all devices in a subnet or use Add by IP to locate all devices in a specified IP range. 
2. Configure the correct IP address as Static IP or DHCP IP. 
3. Double-click the device and start configuration: 

 General: Configure device name, location, time server, and Auto IP report. 
 Security: Configure the accessible IP table and administrator password 
 Networking: Configure IP address (Static or DHCP/BootP) 
 Notification: Specific events (hardware reset, software reset, login failed, IP changed, password changed, 

access IP blocked) can be notified by:  
 SNMP trap: up to four trap servers. 
 Email: up to eight email addresses as recipients.  
 System Log: report to log server. 

 Management: Configure the management interface: 
 Web enable: enable web console. 
 Telnet enable: enable telnet console. 
 SNMP enable: enable SNMP management. Configure community, location, contact, Trap servers. 

 Update Firmware: Update latest firmware to the device. 
 Save / Load:  

 Apply and Save: Apply all changes and save to Flash. 
 Load Default: Load factory default settings, except for the IP address. 
 Reboot Device. 
 Import / Export Configuration: Save the configuration of device as a file. Import the pre-saved 

configuration file to apply to new device. 
4. Go to the port menu and configure the port settings: 

 Serial Settings:  
 Configure the Port alias, baud rate, parity, data bits, stop bits, flow control, and interface. 
 Data packing: Specify advanced data packing options by delimiter or Force TX interval timeout. 

 Service Mode: Choose from Virtual COM, TCP server, TCP client, or UDP service mode for the serial 
port. You can configure up to five hosts to access the serial port at the same time. 

 Notification: Configure Port events like DCD/RI/DSR/CTS change or port connected/disconnected. 

Monitor: Monitor status of device and per port. Configure the monitored items such as VCOM, serial setting, 
device name, IP address, MAC address, Status, TX, RX. 

Setup Wizard: Quick start for common applications and group configurations: 
 Virtual COM Wizard: This wizard helps you configure the serial port(s) to be the Virtual COM port(s) on 

your PC. 
 Group Setup Wizard: This wizard helps you copy one device settings to the other same models. 
 Group Firmware Wizard: This wizard helps you update firmware for a group of devices. 
 Serial Tunnel Wizard: This wizard helps you couple two serial devices to directly communicate via 

Ethernet without the PC 
 Group IP Wizard: Group IP Wizard helps you configure the IP addresses of a group of new devices. The 

devices already in the configuration list will not be included. 

IP Collection: Automatically collect IP address/device name/model/last report of the devices by defined time 
intervals. 

System Log: Show all log messages of the device. View by date. 
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4.1.3 Using SDS-Manager 

Screen Elements 

 

 

File  
File > New SDS-Manager:  
File > Load SDS-Manager: at the dialog box, select a file to load and click Open.  

File > Save SDS-Manager: at the dialog box, select a file to load and click Save. 

File > Virtual COM Wizard: brings you to setup the device serial port(s) and map it to 
Virtual COM as follows: 

STEP 1. Select serial port(s) from available devices. 
STEP 2. Setup these serial ports(s), baudrate, data bits...etc.  
STEP 3. Select the Virtual COM(s) naming. 
STEP 4. Done. 

File > Serial Tunnel Wizard: helps you couple two serial devices to directly 
communicate by Ethernet without the PC:  

STEP 1. Select two devices that should be tunneled together. 
STEP 2. Select serial parameters such as baud rate, data bits. 
STEP 3. Finish. 

File > Group IP Wizard: helps you configure the IP addresses of a group of new 
devices. The devices already in the configuration list will not be included.  

STEP 1. Locate the new devices by broadcast or by IP range.  
STEP 2. Configure the IP range or DHCP IP. 
STEP 3. Start. 

File > Group Setup Wizard: helps you copy one device settings to the other same models: 
STEP 1. Select the device model. 
STEP 2. Select the source device and the destination devices. 
STEP 3. Select the device and port settings to copy. 
STEP 4. Start copying. 
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File > Group Firmware Wizard: helps you to update firmware for a group of devices. 
STEP 1. Select the device model. 
STEP 2. Select the target devices.  
STEP 3. Select the new firmware. 
STEP 4. Go. 

File > Exit: gives options to cancel, or exit and remove the virtual COM, or exit and 
keep the virtual COM resident.  
 
 

Device Configuration 
Device Configuration > Broadcast Search: starts an immediate broadcast search 
for new devices; gives options to cancel, clear all, select all, or add; provides a link to 
the Group IP Wizard in case  you have a lot of IPs that you must re-configure.  
Device Configuration > Add Device by IP: lets you search by Domain Name, IP 
Range, and/or Management Port Number; or lets you cancel the search. 
Device Configuration > Remove Device: lets you remove a selected device from 
the configuration.  
Device Configuration > Import Device Configuration: lets you import a selected device into the configuration. 
Device Configuration > Export Device Configuration: lets you export a selected device out of the 
configuration. 

COM Configuration 
COM Configuration > lets you map or unmap a selected virtual Com; provides tabs for 
configuring serial settings, service mode, and Notifications. 
 

Options 
Options > Network Bandwidth > (Intranet, T1 or faster, Internet 
(default) , ADSL or cable modem, Modem, wireless or lower, 3G, 
ping time > 3 seconds):  

Help 
Help > Help displays the online help content (shown below left). 
Help > About displays the program name / version dialog (shown below right). 
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Search for and Discover Serial Device Servers 
Click the Broadcast button or navigate to the Device Configuration > Broadcast Search menu path. SDS-Manager 
will broadcast to the network and search for all available SDS devices on the network automatically. The default 
IP address of the device is 192.168.1.77. Select the device you want to use and press the Add button. 

You can set a static IP address or use the DHCP client mode to acquire an IP address automatically. Click OK 
and the device will be added.   
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4.1.4 Configure Device Servers 
This section shows and describes each of the tabs and related parameters. Navigate to a device (e.g., SDS 
Manager > Device List > 192.168.1.74) to display a page with tabs for configuring General, Security, Ethernet, 
Notifications, Management, Upgrade Firmware, and Save/Load parameters.  

General tab 
This page lets you perform general device configuration (Device Name/Location, SNTP Server, Auto IP Report). 

 
 

Label Description 
Device Name/Location You can input the device name or related information in this field.  

Using SNTP Time Server 
To set the time via an SNTP time server, check the box and input related 
information such as the SNTP server domain name or IP address and the 
port number, then select a time zone. 

SNTP Server IP Displays the current SNTP Server IP address.  
Port Displays the currently configured port number (e.g., port 123). 

Time Zone Displays the currently configured Time Zone (e.g., ADT - Atlantic Daylight = 
UTC minus 3 hours).  

Auto IP Report 
Check the checkbox to receive IP reports regularly.  By clicking Get Current 
Host, you will get your local IP address. Input a value in the Report Interval 
time field based on how often you want the device server to report its status. 

Apply Only button Click the “Apply Only” button to immediately apply the settings, but not save 
applied settings into the flash memory of the device. 

Apply and Save button Click the “Apply and Save” button immediately apply the settings and to save 
all applied settings into the flash memory of the device. 

Refresh button Click the Refresh button to update the screen content / undo changes made 
since last Save. 
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Security tab 
This page lets you set up access IP tables for your device to allow authorized and deny authorized access, 
thereby ensuring data security and facilitating device management.   

  

Label Description 

Access IP Table 
You can enter the host IP addresses and network masks to prevent 
unauthorized access. Check the Enabled checkbox to enable each IP 
address for access.  

Password 
You can set or change the password to prevent unauthorized access from 
your server. The factory default is no password (empty field). 
Click the Change Password button when done.  

User Name Enter the new User Name.  
Change User Name 
button Click the Change User Name button when done. 
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Ethernet tab 
This page lets you assign the required IP address for the device before it is attached to your network.  
Your network admin should provide the IP address and related settings. The IP address must be unique  
within the network (otherwise a valid network connection can’t be made). You can choose from two possible  
IP configuration modes: Static IP or DHCP/BOOTP. The factory default IP address is 192.168.1.77. 

  

Wire Sub-Tab 

Label Description 
Using Static  IP  Manually assign an IP address to the device.  

Using DHCP/BOOTP Check the box to have the IP address automatically assigned by a DHCP 
server in your network.  

IP Address Enter the IP address of the serial device server.  

Netmask All devices on the network must have the same network mask to 
communicate on the network. 

Gateway Enter the IP address of the router on your network. 

DNS 1 / DNS 2 Enter the IP address of the primary and secondary DNS servers.  
The DNS server translates domain names into IP addresses.  
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Notification tab 
This page lets you specify the events that should be forwarded to the administrator. The events can be sent by  
E-mail, SNMP trap, or Syslog. Status information can be sent to the administrator via Email, SNMP trap, or 
Syslog. This page lets you specify the events to be noticed and the notification methods. Notification methods 
include SNMP Trap, Email, and/or Syslog notification. 

 
 

Label Description 

SNMP Trap 

Check the box to allow the system to send SNMP traps when an event occurs. SNMP 
traps are data packages sent from the SNMP client to the server without being 
explicitly requested. You must set up one or more trap servers that will receive these 
messages if the box is checked.  

Email Notification 
Check the box to allow the system to send emails when an event occurs. You must 
specify the SMTP Server and the email address to use for sending emails if the box 
is checked. 

Syslog Notification 

Check the box to allow the system to send a detailed log to an external Syslog server 
when an event occurs. The syslog will capture all log activity and includes every 
connection source and destination IP address, IP service, and number of bytes 
transferred to help troubleshooting. You must enter a Server IP address and the 
Server Port of the syslog server.  

Notified items 
(Unit Notification) 

Select the checkbox to send an event alert to a remote syslog server: 
Hardware Reset (Cold Start): Rebooting the device from power plug will trigger the 
event. 
Software Reset (Warm Start): Re-booting the device from Reboot Device function 
at the Save/Load menu will trigger the event. 
Login Failed: Using wrong password in console will trigger the event.  
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IP Changed: Changing the network setting will trigger the event. 
Password Changed: Changing the Password will trigger the event.  
Access IP Blocked: Report blocked IP addresses.  

System Log settings You can specify the Server IP address and Port, or click the Using Current Host’s 
Log Server button to specify the current host as the log server. 

 

Notified Items (Port Notification) 

Label Description 

DCD Changed When the DCD (Data Carrier Detect) signal changes, it indicates that the modem 
connection status has changed. A notification will be sent if the box is checked. 

DSR Changed 
When the DSR (Data Set Ready) signal changes, it indicates that the data 
communication equipment is powered off. A notification will be sent if the box is 
checked. 

RI Changed 
When the RI (Ring Indicator) signal changes, it indicates the incoming of a call.  
A notification will be sent if the box is checked. 

CTS Changed 
When the CTS (Clear To Send) signal changes, it indicates that the transmission 
between computer and DCE can proceed.  A notification will be sent if the box is 
checked. 

Port Connected 

In TCP Server Mode, when the device accepts an incoming TCP connection, this 
event will be triggered. In TCP Client Mode, when the device has connected to the 
remote host, this event will be triggered. In Virtual COM Mode, Virtual COM is ready 
to use. A notification will be sent if the box is checked. 

Port Disconnected 
In TCP Server/Client Mode, when the device loses the TCP link, this event will be 
triggered. In Virtual COM Mode, when Virtual COM is not available, this event will be 
triggered. A notification will be sent if the box is checked. 
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Management tab 
This page lets you perform management functions using various interfaces (the Web, Telnet, and SNMP). 

 
 

Label Description 

Web Management Enable Check the box to enable management from the web. Click the Goto 
Web Management button to access the web.  

Telnet Management Enable Check the box to enable management by Telnet. Click the Goto 
Telnet Management button to execute Telnet commands.  

SNMP Management Enable Check the box to enable management by SNMP. 

SNMP Management Settings 
If SNMP Management Enable is checked, you must fill in the SNMP 
settings in these fields by assigning the SNMP Community, 
Location, Contact, and Trap Server parameters.  
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Upgrade Firmware tab 
This page lets you upgrade the device firmware from the Lantronix website. To update device firmware, save the 
file to your host PC, and then specify the file location by clicking the Browsing button, specifying the location, and 
then clicking the Upgrade button.  

Caution: Do not power off this device while upgrading firmware. 

 

Upgrade to a new firmware by browsing to a specific folder. Click the Upgrade button to start the upgrade 
process. 

Label Description 

Firmware Image Provide the path and filename. The firmware image is typically a .bin file or 
a .uImage file. 

Browsing Click the button to browse to and select the desired firmware image file. 
Upgrade Click the button to upgrade the SDS device to the selected firmware image file. 

Refresh Click the button to update the screen content / undo changes made since last 
Save. 

Apply Only Click the button to immediately apply the settings, but not save applied settings 
into the flash memory of the device. 

Apply and Save Click the button to immediately apply the settings and to save all applied 
settings into the flash memory of the device. 

 

 
  

https://www.lantronix.com/


Lantronix              SDSTX3110-124-LRT-B User Guide 

33686 Rev. C https://www.lantronix.com/ 31 

Save/Load tab 
This page lets you save the current config file to a local drive or network location to which your management 
computer can connect.  

 
 

Label Description 

Save Configuration to Flash Click the “Apply and Save” button to save all applied settings into the 
flash memory of the device.  

Load Default 
Changes all parameter settings to factory defaults except network 
settings.  If you want to load all factory default settings, press the 
Reset button on the device front panel (Hardware reset). 

Reboot Device Click this button to re-boot the device; you must broadcast again to 
search for the device (warm start). 

Import Configuration Click this button to retrieve a saved configuration file and apply it to 
the current device.  

Export Configuration 
Click this button to save the current parameters to a file and export it 
to a current host. At the “Save As” dialog, browse to a “Save in” 
location, enter a file name and file type, then click the Save button. 

 

Click the “Apply Only” button to immediately apply the settings, but not save applied settings into the flash 
memory of the device. 

Click the “Apply and Save” button to immediately apply the settings and to save all applied settings into the flash 
memory of the device. 

Click the Refresh button to update the screen content / undo changes made since last Save. 
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4.1.5 Configure Serial Port  
You can configure the settings for each serial port by clicking on the port number in the left pane of the window. 

When you click on a port in the left pane, the screen below displays in the right panel. 

 

This page displays the Serial Settings, Service Mode, and Notification tabs as described and shown in the 
following sections.  
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Serial Settings 
This page lets you configure serial port parameters, serial communications modes, data packing options, and 
event notifications.  

 
 

Label Description 

Port Alias Enables the device to easily identify the serial devices connected to it. 
Enter an identifying name to be identified by the connected device. 

Baudrate 
The rate at which data is transferred over the serial link. When setting to 
9600bps, the serial port will transfer at a maximum of 9600 bits per 
second. From the dropdown select a rate of 110 bps to 560800 bps.  

Parity 

Parity is a simple form of error detection which guards data on the cable 
between the connected devices and the serial port.  
The available Parity options include: 
None: no parity checking is performed, and the parity bit is not 
transmitted.  
Odd: the number of mark bits in the data is counted, and the parity bit is 
asserted or unasserted to obtain an odd number of mark bits.  
Even: the number of mark bits in the data is counted, and the parity bit 
is asserted or unasserted to obtain an even number of mark bits.  
Mark: the parity bit is always set to mark signal condition (logical 1) 
Space:  the last transmitted data bit will always be a logical 0.  

Data Bits 
Choose the number of data bits to transmit: 7 or 8. Data is transmitted 
as a series of seven or eight bits (five and six bit data formats are used 
rarely for specialized communications equipment).   
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Label Description 

Stop Bits 

Choose the number of bits used to indicate the end of a byte. You can 
configure data bytes to be 1 or 2(1.5). If stop bits is 1.5, the stop bit is 
transferred for 150% of the normal time used to transfer on bit. Both the 
computer and the peripheral device must be configured to transmit the 
same number of stop bits.  

Flow Control 

Serial communications consists of hardware flow control and software 
flow control, so called because the control is handled by software or 
hardware. XOFF and XON is software flow control, while RTS/CTS or 
DTR/DSR is hardware flow control.  
Choose XOFF to tell the computer to stop sending data; then the 
receiving side will send an XOFF character over its Tx line to tell the 
transmitting side to stop transmitting.  
Choose XON to tell the computer to begin sending data again; then the 
receiving side will send an XON character over its Tx line to tell the 
transmitting side to resume transmitting. In hardware flow control mode, 
when the device is ready to receive data, it sends a CTS (Clear To 
Send) signal to the device on the other end. When a device  
has something it wants to send, it will send a RTS (Ready To Send) 
signal and waits for a CTS signal to come back its way. These signals 
are sent apart from the data itself on separate wires.  

Interface 

Choose an interface for your serial device. Available interfaces include 
RS-232, RS-422, RS-485(2-wires), and RS-485(4-wires). 
After a Virtual COM has been mapped to a port, changes to the serial 
settings of that port (e.g., from RS232 to RS422) should not be made. 

Performance Throughput: guarantees highest transmission speed. 
Latency: guarantees shortest response time. 

Delimiter Settings 

Serial to Ethernet / Ethernet to Serial: For advanced data packing 
options, you can specify delimiters for Serial to Ethernet and / or 
Ethernet to Serial communications. You can define up to four delimiters 
(00~FF, Hex) for each way. The data will be hold until the delimiters are 
received or the option. 
Flush Serial to Ethernet data buffer times out. 0 means disable. 
Factory default is 0.  
Flush Data Buffer After: The received data will be queuing in the buffer 
until all the delimiters are matched. When the buffer is full (4K Bytes) or 
after "flush S2E data buffer" timeout the data will also be  
sent. You can set the time from 0 to 65535 seconds. 

Flush Ethernet to Serial Data 
Buffer After 

Enter 0 - 65535 milliseconds as the amount of time to wait to “flush 
E2S”. The received data will be queueing in the buffer until all the 
delimiters are matched. Ehen the buffer is full (4K bytes) or after “flush 
E2S data buffer” timeout, the data will be sent. 

Force TX Interval time 

Force TX interval time is to specify the timeout when no data has been 
transmitted. When the timeout is reached or TX buffer is full (4K Bytes), 
the queued data will be sent. 0 means disable.  
The factory default value is 0. 
The received data will be queueing in TX buffer until TX interval time is 
timeout or TX buffer is full (4K bytes), the data will also be sent.  
The value 0 means disable. 
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4.2 Service Mode 

4.2.1 Virtual COM Mode 
In Virtual COM Mode, the driver establishes a transparent connection between a host and the serial device by 
mapping the port of the serial server serial port to a local COM port on the host computer. Virtual COM Mode 
supports up to five simultaneous connections, so that multiple hosts can send or receive data by the same serial 
device at the same time.  

 
 

Label Description 
Data Port Set the port number for data transmission. 
Edit IP Port Number Check the checkbox to allow changing the Data Port number.  
Control Port Displays the control port number (read only). 
Map Virtual COM Click to select a Virtual COM name to map on. 

Idle Timeout 

When a serial port stops data transmission for a defined period of 
time (Idle Timeout), the connection will be closed and the port will be 
freed and try to connect with other hosts. 0 means the function is 
disabled which is also the factory default value. If multilink is 
configured, only the first host connection is effective for this setting. 

Alive Check 

The serial device will send a TCP alive-check package in each 
defined time interval (Alive Check) to remote host to check the status 
of TCP connections. If the TCP connection is not alive, the 
connection will be closed and the port will be freed. 0 means the 
function is disabled which is also the factory default value. 
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Max Connections The number of max connections can be supported simultaneously is 
5; default value is 1. 

Destination Host Displays one to four connected destination hosts. 

VCOM Name Displays the related VCOM name, or a message like Waiting for 
VCOM connect.  

Goto VCOM Click the button to go to the related VCOM port. 
Unmap VCOM Click the button to un-map the related VCOM port. 

 
  

https://www.lantronix.com/


Lantronix              SDSTX3110-124-LRT-B User Guide 

33686 Rev. C https://www.lantronix.com/ 37 

4.2.2 TCP Server Mode 
In TCP Server Mode, the serial port on the device server is assigned a unique port number.  

The host computer initiates contact with the device server, establishes the connection, and receives data from the 
serial device. Five simultaneous connections are supported in this mode, enabling multiple hosts to collect data 
from the same serial device at the same time. 

 
 

Label Description 

TCP Server Settings 

Check the required checkbox: 
Encryption with SSL: Allows encryption via Secure Socket Layer.  
Telnet Negotiation: Allows a client or a server to help provide an enhanced 
user experience. 

Data Port Set the port number for data transmission. 
Auto Scan Click to scan the data port automatically. 

Idle Timeout 

When a serial port stops data transmission for a defined period of time (Idle 
Timeout), the connection will be closed and the port will be freed and try to 
connect with other hosts.  
0 means the function is disabled which is also the factory default value.  
If multilink is configured, only the first host connection is effective for this 
setting. 

Alive Check 

The serial device will send a TCP alive-check package in each defined time 
interval (Alive Check) to remote host to check the status of TCP connections. 
If the TCP connection is not alive, the connection will be closed and the port 
will be freed. 0 means the function is disabled which is also the factory default 
value. 
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Max Connections Up to 5 connections can be supported simultaneously; the default value is 1. 
Destination Host Input the IP address of one to five destination hosts. 
Disconnect Click to disconnect a connected destination host. 

 

  

https://www.lantronix.com/


Lantronix              SDSTX3110-124-LRT-B User Guide 

33686 Rev. C https://www.lantronix.com/ 39 

4.2.3 TCP Client Mode 
In TCP Client mode, the device can establish a TCP connection with the server by the method you have settled 
(Startup or any character). After the data has been transferred, the device can disconnect automatically from the 
server by using the TCP alive check time or idle time settings. 

 
 

Label Description 
Encryption with SSL Check to allow encryption via Secure Socket Layer. 
Destination Host  Input the IP address of the host. 
Port Set the port number of data port. 

Idle Timeout 

When a serial port stops data transmission for a defined period of 
time (Idle Timeout), the connection will be closed and the port will  
be freed and try to connect with other hosts. 0 means the function is 
disabled which is the factory default value. If multilink is configured, 
only the first host connection is effective for this setting. 

Alive Check 

The serial device will send a TCP alive-check package in each defined 
time interval (Alive Check) to remote host to check the TCP connection. 
If the TCP connection is not alive, the connection will be closed and the 
port will be freed. 0 means the function is disabled which is the factory 
default value. 

Connect on Startup The TCP Client will build a TCP connection once the connected serial 
device is started. 

Connect on Any Character The TCP Client will build a TCP connection once the connected serial 
device starts to send data. 
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Auto Scan Click the button to scan for the listening port number of the device. 
Multilink Destination Host Enter the Multilink Destination Host IP address.  
Multilink Port Enter the Multilink Port number. 
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4.2.4 UDP Mode 
Compared to TCP communication, UDP is faster and more efficient, as you can unicast or multicast data from the 
serial device server to host computers; the serial device server can also receive data from one or multiple hosts.  

 
 

Label Description 
Listening Port  IP port for listening for incoming messages. The default is port 4016.  
Auto Scan Click the button to scan for the listening port number of the device. 

Destination Host Begin / End 
If there are more than one destination hosts, specify the IP address 
range by inputting a value in destination host IP begin / end fields. 
You can also auto scan the sending port number of the device. 

Sending Port IP port for sending outgoing messages. 

Messages 

Message:  Apply or Discard  The settings has been changed. Apply to device or discard? 

Meaning:  You made changes and then left the page and are being prompted to either apply those changes or 
discard the changes. 

Recovery:  1. Click the Cancel button and stay on the page. 2. Click the Discard button and go to another page. 
3. Click the Apply Only button and go to another page.   4. Click the Apply and Save button and go to another 
page. 
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Message: Warning  UDP mode’s ‘Port’ is in used on Device. 

Meaning: You tried to configure the same UDP Listening or UDP Sending port number for two instances.  

Recovery:  1. Click the OK button to clear the Warning dialog. 2. Change a UDP port number.  

    

https://www.lantronix.com/


Lantronix              SDSTX3110-124-LRT-B User Guide 

33686 Rev. C https://www.lantronix.com/ 43 

4.2.5 VCOM List 
The VCOM List page displays read-only information (Number, VCOM, Settings, Device Name, MAC address, and 
status), and provides a button to Select Monitor Items.  

 

The VCOM List > COMx > Serial Settings tab displays Link Information and current serial device settings 
(Baudrate, Stop Bits, Parity, Flow Control, Data Bits, and Interface selections). 

  

The VCOM List > COMx > Connection Settings tab displays Link Information and current serial settings 
(Remote Device IP, Port #, and Connection Status). 

     
The VCOM List > COMx > Statistics tab displays Link Information and current Statistics (TX Bytes, RX Bytes, 
and Reconnect Times). 
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4.2.6 Setup Wizard 
The Setup Wizard page displays all of the wizards available: Virtual COM Wizard, Serial 
Tunnel Wizard, Group IP Wizard, Group Setup Wizard, and Group Firmware Wizard. 

4.2.8 IP Collection 
The IP Collection page displays automatically collected IP address, device name, model, last report of devices by 
a defined time interval. 

4.2.9 System Log 
The System log page displays current log messages of the device, lets you clear the messages, and lets you 
display messages based on a Year and Month selection. 

 
 

 

 
  

https://www.lantronix.com/


Lantronix              SDSTX3110-124-LRT-B User Guide 

33686 Rev. C https://www.lantronix.com/ 45 

4.3 Web Management 
The SDS can be managed via a built-in webserver running Internet Explorer v 5.0 or above or other web browsers 
such as Chrome. This allows simple, remote device monitoring and configuration, such as firmware upgrades.  

4.3.1 Management via Web Browser 
Follow the steps below to manage your SDS via a Web browser.  

System Login 
1. Launch a Web browser. 

 
2. Type the IP address of the device and press Enter.  A login screen displays: 

     
3. Type the default username root. Type the default password root. You may set up a different user name 

and password later on the IP Configuration page.  
4. Press Enter or click OK; the System Information page displays. 

Note: you can use the following default values:   
IP address:  192.168.1.77 
Subnet Mask:  255.255.255.0 
Default Gateway: 192.168.1.254 
User Name:  root 
Password:  root 

After logging in, the System Information page displays: 

 
The left side of the page provides links to various settings. Click on a link to display its configuration page. 
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4.3.2 System 

4.3.2.1 Time (SNTP) 
The SNTP (Simple Network Time Protocol) lets you synchronize the time on your system to the time on the 
Internet. SNTP will synchronize your computer system time with a server that has already been synchronized by a 
source such as a radio, satellite receiver, or modem. 

 
 

Label Description 
Name Enter the model name of the device. 
SNTP Enable or disable SNTP function. 
Time Zone Choose the time zone according to the location of the device. 
Local Time Set up the local time. 
Time Server Enter the address of the time server. 
Telnet Console Click to enable or disable Telnet console function. 

Click the Apply button when done to apply the changes. 
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The table below lists various location time zones: 

Label Conversion from UTC Time at 12:00 UTC 
November Time Zone - 1 hour  11 am 
Oscar Time Zone -2 hours  10 am 
ADT -  Atlantic Daylight -3 hours  9 am 
AST - Atlantic Standard EDT - Eastern Daylight -4 hours  8 am 
EST - Eastern Standard CDT - Central Daylight -5 hours  7 am 
CST - Central Standard MDT - Mountain Daylight -6 hours  6 am 
MST - Mountain Standard PDT - Pacific Daylight -7 hours  5 am 
PST - Pacific Standard ADT - Alaskan Daylight -8 hours  4 am 
ALA - Alaskan Standard -9 hours  3 am 
HAW - Hawaiian Standard -10 hours  2 am 
Nome, Alaska  -11 hours  1 am 
CET - Central European FWT - French Winter  
MET - Middle European MEWT - Middle European 
Winter SWT - Swedish Winter 

+1 hours 1 pm 

EET - Eastern European, USSR Zone 1 +2 hours 2 pm 
BT - Baghdad, USSR Zone 2 +3 hours 3 pm 
ZP4 - USSR Zone 3 +4 hours 4 pm 
ZP5 - USSR Zone 4 +5 hours 5 pm 
ZP6 - USSR Zone 5 +6 hours  6 pm 
WAST - West Australian Standard +7 hours  7 pm 
CCT - China Coast, USSR Zone 7 +8 hours  8 pm 
JST - Japan Standard, USSR Zone 8 +9 hours  9 pm 
EAST - East Australian +10 hours  10 pm 
Standard GST Guam Standard, USSR Zone 9   
IDLE - International Date Line NZST - New Zealand 
Standard NZT - New Zealand +12 hours  Midnight 
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4.3.2.2 IP Configuration 
This page lets you configure IP settings for your device. You can assign an IP address manually or leave it to 
DHCP/BOOTP servers which will reply with an automatically generated IP address and subnet mask for the 
device when they receive the request. The IP address must be unique and within the network, otherwise the 
device will not have a valid connection to the network. Select Static IP if you are using a fixed IP address.  

Click Apply after you complete configuration. The default values are IP address: 192.168.1.77, Subnet Mask: 
255.255.255.0, Default Gateway: 192.168.1.254, User Name: root, Password: root.  

 
 

Label Description 

IP Configuration 

Choose to use a static or DHCP-assigned IP. If you choose DHCP, the 
following fields will gray out. 

Static: Enter an IP address for the device. Select Static IP if you are using a 
fixed IP address. 

DHCP/BOOTP: allows the IP address of the device to be automatically 
assigned by a configuration server. 

IP Address Enter the IP address that identifies the server on the TCP/IP network.  
The default is 192.168.10.1. 

Netmask Enter a subnet mask for the device. The default is 255.255.255.0. 

Gateway Enter the IP address of the router that provides network access outside the 
server’s LAN. The default is 192.168.10.254. 

DNS Server 1/2 Enter the IP address of the primary and secondary domain name server. 

Auto Report to IP Specify an IP address for reports generated by the Auto report function to be 
automatically sent to. 

Auto Report to TCP Port Specify a TCP Port for reports generated by the Auto report function to be 
automatically sent to. 

Auto Report Interval Specify a time interval for which reports will be delivered. 

Click the Apply button when done to apply the changes. 
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4.3.2.3 User Authentication 
This page lets you change your password.  

 
 

Label Description 
User Name Enter the default User Name (root in lower case). 
Old Password Enter the existing password that is used to log in. 
New Password Enter a new password that will be used to log in. 
Confirm New Password Retype the new password to confirm. 

Click the Apply button when done to apply the changes. 
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4.3.3 Port Serial Setting 

4.3.3.1 Serial Configuration 
This page lets you configure serial port parameters.  

 
 

Label Description 

Port Port number dropdown to select Port 1 or Port 1 - Port 4, depending on your 
Model (SDSTX3110-124-LRT-B shown above). 

Port Alias Enter the port number that modem is connected to. 

Interface 

Choose an interface for your serial device. Available interfaces include  
RS-232, RS-422, RS-485(2-wires), and RS-485(4-wires), 
After a Virtual COM has been mapped to a port, changes to the serial settings 
of that port (e.g., from RS232 to RS422) should not be made. 

Baud Rate Choose a baud rate in the range between 1200 bps and 460800 bps. 

Data Bits 
Choose the number of data bits to transmit. You can configure data bits to be 
7 or 8. Data is transmitted as a series of seven or eight bits (five and six bit 
data formats are used rarely for specialized communications equipment). 

Stop Bits 

Choose the number of bits used to indicate the end of a byte. 
You can configure stop bits to be 1 or 2(1.5). If Stop Bits is 1.5, the stop bit is 
transferred for 150% of the normal time used to transfer one bit. Both the 
computer and the peripheral device must be configured to transmit the same 
number of stop bits. 

Parity 

Chose the method of detecting errors in transmission. Parity control bit 
modes include None, Odd, Even, Mark, and Space. 

None: parity checking is not performed and the parity bit is not transmitted. 

Odd: the number of mark bits in the data is counted, and the parity bit is 
asserted or unasserted to obtain an odd number of mark bits. 

Even: the number of mark bits in the data is counted, and the parity bit is 
asserted or unasserted to obtain an even number of mark bits. 
Mark: the parity bit is always set to the mark signal condition (logical 1).  
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Label Description 

Space: the last transmitted data bit will always be a logical 0 

Flow Control 

Serial communication consists of hardware flow control and software flow 
control, so called as the control is handled by software or hardware.  
XOFF and XON is software flow control while RTS/CTS or DTR/DSR is 
hardware flow control.  

Choose XOFF to tell the computer to stop sending data; then  
the receiving side will send an XOFF character over its Tx line  
to tell the transmitting side to stop transmitting.  

Choose XON to tell the computer to begin sending data again; then the 
receiving side will send an XON character over its Tx line to tell  
the transmitting side to resume transmitting. In hardware flow control mode, 
when the device is ready to receive data, it sends a CTS (Clear To Send) 
signal to the device on the other end.  
When a device has something it wants to send, it will send a RTS (Ready To 
Send) signal and waits for a CTS signal to come back its way. These signals 
are sent apart from the data itself on separate wires. 

Force TX Interval Time 
Force TX interval time is to specify the timeout when no data has been 
transmitted. When the timeout is reached or TX buffer is full (4K Bytes), the 
queued data will be sent. 0 means disable. Factory default value is 0. 

Performance Throughput: This mode optimized for highest transmission speed.   
Latency: This mode optimized for shortest response time. 

Click the Apply button when done to apply the changes. 
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4.3.2.2 Port Profile 
This page lets you configure serial port parameters. 

 
 

Label Description 

Port Port number dropdown to select Port 1 or Port 1 - Port 4, depending on your 
Model (SDSTX3110-124-LRT-B shown above). 

Local TCP Port 
The TCP port the device uses to listen to connections, and that other devices 
must use to contact the device. To avoid conflicts with well known TCP ports, 
the default is set to 4006. 

Mode The existing mode (e.g., Serial to Ethernet or Ethernet to Serial - read only). 

Flush Data Buffer After 

The received data will be queuing in the buffer until all the delimiters are 
matched. When the buffer is full (4K Bytes) or after "flush S2E data buffer" 
timeout the data will also be sent. You can set the time from 0 to 65535 
milliseconds (ms). 

Delimiter(Hex 00~ff) 

For advanced data packing options, you can specify delimiters for Serial to 
Ethernet and / or Ethernet to Serial communications. You can define up to 
four delimiters (00~FF, Hex) for each way. The data will be hold until the 
delimiters are received or the option Flush Serial to Ethernet data buffer times 
out. 0 means disable. Factory default is 0. 

Click the Apply button when done to apply the changes. 
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4.3.2.3 Service Mode 
In Virtual COM Mode, the driver establishes a transparent connection between the host and the serial device by 
mapping the port of the serial server to a local COM port on the host computer. Virtual COM Mode also supports 
up to 5 simultaneous connections, so that multiple hosts can send or receive data by the same serial device at the 
same time. Click the Apply button when done to apply the changes. 

 
. 

Label Description 
Data Encryption Click on the radio button to enable or disable SSL data encryption. 

Service Mode 

Dropdown to select the service mode (e.g., Virtual COM Mode). 
Virtual COM Mode: the driver establishes a transparent connection between a 
host and the serial device by mapping the port of the serial server serial port to a 
local COM port on the host computer. Virtual COM Mode supports up to five 
simultaneous connections, so that multiple hosts can send or receive data by the 
same serial device at the same time. 
TCP Server Mode: the serial port on the device server is assigned a unique port 
number. 
TCP Client Mode: the device can establish a TCP connection with the server by 
the method you set (Startup or any character). After the data has been 
transferred, the device can disconnect automatically from the server by using the 
TCP alive check time or idle timeout settings.  
UDP Mode: In UDP mode, you can uni-cast or multi-cast data from the serial 
device server to host computers, and the serial device can also receive data 
from one or multiple hosts. Compared to TCP communication, UDP is faster and 
more efficient. 

Idle Timeout 

When the serial port stops data transmission for a defined period of time, the 
connection will be closed and the port will be freed and try to connect with other 
hosts. 0 indicate disable this function. Factory default value is 0. If Multilink is 
configured, only the first host connection is effective for this setting. 

Alive Check 

The serial device will send TCP alive-check packages in each defined time 
interval to remote host to check the TCP connection.  
If the TCP connection is not alive, the connection will be closed and the port will 
be freed. 0 indicate disable this function. Factory default is 0. 

Max Connection 1 to 5 simultaneous connections are supported; the default is 1 connection. 
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4.4.1 TCP Server Mode 
In TCP Server Mode, the SDS Manager is configured with a unique port combination on a TCP/IP network. In this 
case, DS waits passively to be contacted by the device. After the device establishes a connection with the serial 
device, it can then proceed with data transmission. TCP Server mode also supports up to 5 simultaneous 
connections, so that multiple device can receive data from the same serial device at the same time. 

  
 

Label Description 
Data Encryption Click on the radio button to enable or disable data encryption. 

Telnet Negotiation 
Check the radio button to either Enable or Disable Telnet Negotiation. 
The default is Disabled. Telnet negotiation allows a client or a server 
to help provide an enhanced user experience. 

TCP Server Port Enter the TCP server port. The default is port 4000. 

Idle Timeout 

When serial port stops data transmission for a defined period of time, 
the connection will be closed and the port will be freed and try to 
connect with other hosts. 0 indicate disable this function.  
The factory default value is 0. If Multilink is configured, only the first 
host connection is effective for this setting. 

Alive Check 

The serial device will send TCP alive-check packages in each 
defined time interval to remote host to check the TCP connection.  
If the TCP connection is not alive, the connection will be closed and 
the port will be freed. 0 indicate disable this function. The factory 
default is 0. 

Max Connection 

The serial device will send TCP alive-check packages in each 
defined time interval to remote host to check the TCP connection.  
If the TCP connection is not alive, the connection will be closed and 
the port will be freed. 0 indicate disable this function. The factory 
default is 0. 

Click the Apply button when done to apply the changes. 
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4.4.2 TCP Client Mode 
In TCP Client Mode, the device can establish a TCP connection with the server by the method you set (Startup or 
Any Character). After the data has been transferred, the device can disconnect automatically from the server by 
using the TCP alive check time or idle timeout settings. 

  
 

Label Description 
Data Encryption Click on the radio button to enable or disable data encryption. 
Destination Host Set the IP address of host and the port number of data port. 

Idle Timeout 

When serial port stops data transmission for a defined period of  
time, the connection will be closed and the port will be freed and try 
to connect with other hosts. 0 indicate disable this function.  
Factory default value is 0. If Multilink is configured, only the first host 
connection is effective for this setting. 

Alive Check 

The serial device will send TCP alive-check packages in each 
defined time interval to remote host to check the TCP connection.  
If the TCP connection is not alive, the connection will be closed and 
the port will be freed. 0 indicate disable this function. Factory default 
is 0. 

Connect on Startup The TCP Client will build TCP connection once the connected serial 
device is started. 

Connect on Any Character The TCP Client will build TCP connection once the connected serial 
device starts to send data. 

Click the Apply button when done to apply the changes. 
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4.4.3 UDP Mode 
Compared to TCP communication, UDP is faster and more efficient. In UDP mode, you can uni-cast or multi-cast 
data from the serial device server to host computers, and the serial device can also receive data from one or 
multiple hosts. 

  
 

Label Description 

Listen Port Allows the user to set a new TCP port number to listen on rather than 
the default value of the device. The default is port 4000. 

Host Start IP /  
Host End IP 

If there are more than one destination hosts, specify the IP address 
range by inputting a value in Host Start / End IP. You can also auto 
scan the sending port number of the device.  
The valid range for both is 1.0.0.1 to 254.255.255.254. 

Send Port Set the send port number. The valid range is 1-65,535. 

Click the Apply button when done to apply the changes. 
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4.4.4 Management 

4.4.4.1 Access IP Control 
The Access IP Control List lets you add host IP addresses to prevent unauthorized access. If a host’s IP address 
is in the accessible IP table, the host will be allowed to access the SDS Manager.  

 
 

Label Description 

Enable IP Filtering 
Leaving the box unchecked means any host can access the device 
server. The default is unchecked. Check the box to enable IP filtering 
(whitelist) of the specified IP addresses. 

Activate the IP Check the box to activate the IP address. 

IP Address 
Only the host with the specified IP address can access the device 
server. The format should be IP address /255.255.255.255 (e.g., 
“192.168.0.1/255.255.255.255”). 

Netmask 
Only the host on the specified subnet can access the device server. 
The format should be IP address /255.255.255.0 (e.g.,  
“192.168.0.1/255.255.255.0”). 

Click the Apply button when done to apply the changes. 
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4.4.4.2 SMTP/SNMP Configuration 
Email Server configurations include the mail server’s IP address or domain. If authentication is required, you must 
specify your username and password. You can set up to four email addresses for receiving notifications. 

SNMP server configurations include the SNMP trap server IP address, community, location and contact. You can 
set up to four SNMP addresses you for receiving notifications. 

 
 

Label Description 

SMTP Server Specify the SMTP Trap Server IP address to use for sending emails if the box 
is checked on the Notification tab. 

Port Specify the SMTP Server port number to use for sending emails if the box is 
checked on the Notification tab. The default is Port 25.  
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Label Description 
My server requires 
authentication Checkbox to check if an authentication is wanted.  

User Name Enter a user name if the My server requires authentication checkbox is 
checked.  

Password  Enter a password if the My server requires authentication checkbox is 
checked. 

E-mail Sender The e-mail address of the sender.  
E-mail Address 1 - 4 Enter one to four e-mail recipients to receive notifications. 
SNMP Server 1 - 4  Enter one to four SNMP Server IP addresses.  
Community The SNMP Community  
Location The SNMP server location.  
Contact The SNMP server contact name.  
Syslog Server IP  The Syslog Server IP address.  
Syslog Server Port  The Syslog Server Port number. 

 

Click the Apply button when done to apply the changes. 
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4.4.4.3 System Event Configuration 
Specify the events that are to be reported to the administrator. The notification of events can be done via e-mail, 
SNMP trap, and/or system log. 

 
 

Label Description 

Hardware Reset (Cold Start) 

This refers to starting the system from power off (in contrast with 
warm start). When performing a cold start, SDS will automatically 
issue an auto warning message via e-mail, logs, or SNMP trap after 
booting. 

Software Reset (Warm Start) 
This refers to restarting the computer without turning the power off. 
When performing a warm start, SDS will automatically send an e-
mail, log or SNMP trap after rebooting. 

Login Failed When unauthorized access from the console or Web interface 
occurs, a notification will be sent. 

IP Address Changed When the IP address of the device is changed, a notification will be 
sent. 

Password Changed When the password of the device is changed, a notification will be 
sent. 

Access IP Blocked When the host accesses the device with a blocked IP address, a 
notification will be sent. 

Port Event Notification At the dropdown select the port on which to get event notifications. 

DCD Changed When a DCD (Data Carrier Detect) signal changes, indicating  
modem connection status has been changed, a notification is sent. 

DSR Changed When a DSR (Data Set Ready) signal changes, indicating data 
communication equipment is powered off, a notification will be sent. 

RI Changed When a RI (Ring Indicator) signal changes, indicating there is an 
incoming call, a notification will be sent. 

CTS Changed When a CTS (Clear To Send) signal changes, indicating transmission 
between computer and DCE can proceed, a notification will be sent. 
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Label Description 

Port Connected 

In TCP Server Mode, when the device accepts an incoming TCP 
connection, this event will be triggered. In TCP Client Mode, when 
the device has connected to the remote host, the event will be 
triggered. In Virtual COM Mode, when Virtual COM is ready to use, 
this event will be triggered. A notification will be sent when an event is 
triggered. 

Port Disconnected 

In TCP Server/Client Mode, when the device loses the TCP link, this 
event will be triggered. In Virtual COM Mode, when Virtual COM is 
not available, this event will be triggered. A  notification will be sent 
when an event is triggered. 

Click the Apply button when done to apply the changes. 

 

 
  

https://www.lantronix.com/


Lantronix              SDSTX3110-124-LRT-B User Guide 

33686 Rev. C https://www.lantronix.com/ 62 

4.4.5 Factory Default / Restore Config / Upgrade Firmware / Reboot 
The Save/Reboot menu path lets you: 

• Reset to the SDS to its Factory Defaults, 
• Save current values from the device as a backup file,  
• Restore the device to previous settings by downloading a configuration file,   
• Upgrade SDS device firmware, and  
• Reboot (restart) the SDS device. 

 
 

Button 
(Function) Description 

Reset  
Reset to Factory Defaults 

Press Reset for five seconds (Hardware restore) and it will load default 
configurations to the system except the network settings. 

Restore  
Restore Saved Config 

Restore to previous settings using previously exported configurations. 
Browse to the configuration file you want to use and click Restore. 

Backup  
Backup Current Config Export the current configuration to a file. 

Upgrade  
Upgrade Firmware 

Upgrade to a new firmware by browsing to a specific folder. Note: 
Please DO NOT power off this device while upgrading firmware.  

Reboot  
Reboot Device Reboot the device server (warm start). 
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Factory Default 
This page lets you reset the SDS device to the factory default configuration. 

 
1. Navigate to the Save/Reboot menu path.  

2. Click the Reset button to reset all configurations to their default values.   

 

3. At the prompt click the Reboot button.  

 

4. After the message (Rebooting now    Please wait ...) clears, the System Information page displays. 
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Restore Configuration  
You can restore the previous saved configuration to Device Server.  

File to restore:    

 
1. Navigate to the Save/Reboot menu path.  

2. Click the Restore button. 

3. At the webpage message (Please choose a config file to import!) click the OK button.   

4. Browse to and select a saved config file to be restored. 

 
5. Click the Open button.  

 
5. Verify the file displayed is the one you want to restore, and then click the Restore button. 

Messages:  
Importing failed! 
Please choose a config file to import! 
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Backup Configuration 
You can save current EEPROM value from the Device Server as a backup file of configuration.  

 

1. Navigate to the Save/Reboot menu path.  

2. Click the Backup button. A message displays (e.g., Do you want to open or save export.conf from 
192.168.1.77?). 

 

3. Select Save and Open.  The file is saved; you can then select a program in which to view the file (e.g., 
WordPad, as shown below). 
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Upgrade Firmware 
Specify the firmware image to upgrade.  

Note: Please DO NOT power off this device while upgrading firmware.  

Firmware:   

 

1. Navigate to the Save/Reboot menu path.  

2. Click the Upgrade button.  

3. Browse to and select the upgrade file. 

 

4. Verify the file displayed is the one you want to upgrade to, and then click the Upgrade button. 

Messages:  
Upgrading failed! 
Firmware upgrade success. Rebooting now, please wait... 
192.168.1.77 didn’t send any data. 
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Reboot Device 
Please click [Reboot] button to restart device.  

 
1. Navigate to the Save/Reboot menu path.  

2. Click the Reboot button to reset all configurations to their default values.   

 

3. At the prompt click the Reboot button.  

 

4. After the message (Rebooting now    Please wait ...) clears, the System Information page displays. 
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4.5 Configuration by SSH Console 

4.5.1 Connect to SSH Console 
You can use an SSH tool such as PuTTY to access the SSH console of the device.  

The PuTTY settings are: Serial line to connect to: COM1, Speed (baud): 9600, Data bits: 8, Stop bits: 1,  
Parity: None, Flow control: XON/XOFF. Click the Open button to start. Note that PuTTY startup may take around 
20 seconds.  

     

The initial SSH console interface is shown below.   
login as: root 
root@192.168.1.77's password: root 
 
***************************************** 
*** Lantronix Industrial Serial Device Server Commander *** 
***************************************** 
----------------------------------------- 
1. Overview 
2. General Settings 
3. Network Settings 
4. Ports settings 
5. Security(Accessible IP) Settings 
6. Notification(Auto Warning) Settings 
C. Change Password 
L. Load Factory Default 
S. Save configuration 
R. Reboot 
Q. Exit & Logout 
 
Select one function (0-9,A,C,L,S,R,Q): 
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1. Overview 
Displays an overview of the device information: 
Select one function (0-9,A,C,L,S,R,Q):  1 
 
----------------------------------------- 
[Overview] 
  Model Name :        SDSTX3110-124-LRT-B 
  MAC Address :       00-c0-f2-5a-54-c8 
  Firmware Version :  1.4 
  Device name :       DeviceServer-DEFAULT 
 
Press ENTER to continue. 

2. General Settings 
Displays additional device information: 
Select one function (0-9,A,C,L,S,R,Q):  2 
 
----------------------------------------- 
[General Settings] 
<Basic Setting> 
 1. Device name :      DeviceServer-DEFAULT 
<SNTP Time> 
 2. SNTP Enable   Disable 
 3. SNTP server :      pool.ntp.org 
 4. Port :             123 
 5. Time Zone :        Asia/Taipei 
<Management> 
 6. Web console :      Enable 
<SNMP management> 
 7. Community : 
 8. Location : 
 9. Contact : 
Q. Exit 
 
Select one function (1-8,Q): 

1. Device name: select 1 and enter the new device name. 

Select one function (1-8,Q):  1 
----------------------------------------- 
[Server name] 
Input new server name or (Q)uit: xxxxxczz98 

2. SNTP Enable: select 2 and select enable or disable. 

Select one function (1-8,Q):  2 
----------------------------------------- 
[SNTP Enable] 
Input 1(Enable) or 2(Disable) : 1 

3. SNTP server: select 3 and enter the new Time server IP address.  

Select one function (1-8,Q):  3 
----------------------------------------- 
[Time server] 
Input new Time server address or (Q)uit: 
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4. Port: select 4 and enter the new port number.  

Select one function (1-8,Q):  4 
----------------------------------------- 
[SNTP time Server port] 
Input new port number or (Q)uit: 

5. Time Zone: select 5 and select the desired time zone. 
Select one function (1-8,Q):  5 
----------------------------------------- 
[Time zone] 
Please select one of following choice : 
0. (GMT-12:00)Eniwetok, Kwajalein 
1. (GMT-11:00)Midway Island, Samoa 
2. (GMT-10:00)Hawaii 
3. (GMT-09:00)Alaska 
4. (GMT-08:00)Pacific Time (US &amp; Canada); Tijuana 
5. (GMT-07:00)Arizona 
6. (GMT-07:00)Mountain Time (US &amp; Canada) 
7. (GMT-06:00)Central Time (US &amp; Canada) 
8. (GMT-06:00)Mexico City, Tegucigalpa 
9. (GMT-06:00)Saskatchewan 
          Press Q to exit or ENTER to continue... 
 

 6. Web console:  select 6 and select enable or disable. 
Select one function (1-8,Q):  6 
----------------------------------------- 
[Web console] 
Input 1(Enable) or 2(Disable) : 
 

 7. Community: select 7 and enter the SNMP Community name. 
Select one function (1-8,Q):  7 
----------------------------------------- 
[SNMP Community] 
Input Get/Set Request Community (max 64) or Q(uit): 
 

 8. Location: select 8 and enter the SNMP Get/Set Request location.  
Select one function (1-8,Q):  8 
----------------------------------------- 
[SNMP Location] 
Input Get/Set Request Location (max 64) or Q(uit): 
 

 9. Contact: select 9 and enter the SNMP Get/Set Request contact name. 
Select one function (1-8,Q):  9 
----------------------------------------- 
[SNMP Contact] 
Input Get/Set Request Contact (max 64) or Q(uit): 
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3. Network Settings 

Displays current network settings: 
Select one function (0-9,A,C,L,S,R,Q):  3 
 
----------------------------------------- 
<Network Setting> 
 1. IP configuration       Static 
 2. IP address             192.168.1.77 
 3. Netmask                255.255.255.0 
 4. Gateway                192.168.1.254 
 5. DNS server 1           192.168.1.254 
 6. DNS server 2 
 A. Apply New Network Settings 
 R. Refresh Status 
 * Please select (A)"Apply New Network Settings" 
   after changed your settings 
<IP Address report> 
 7. To IP 
 8. To TCP port            Set "To IP" first 
 9. Period(sec)            Set "To IP" first 
Q. Exit 
 
Select one function (1-9,A,R,Q): 
 

1. IP configuration: 

Select one function (1-9,A,R,Q):  1 

----------------------------------------- 

[IP configuration] 

Input new IP configuration setting, 

(1)static, (2)DHCP/BOOTP or (Q)uit: 

2.  IP address: 

Select one function (1-9,A,R,Q):  2 

----------------------------------------- 

[IP address] 

Input new IP address or (Q)uit:  192.168.1.77 

3. Netmask: 

Select one function (1-9,A,R,Q):  3 
----------------------------------------- 
[Netmask address] 
Input new Netmask address or (Q)uit:  255.255.255.0 
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4. Gateway: 

Select one function (1-9,A,R,Q):  5 
----------------------------------------- 
[Gateway address] 
Input new Gateway address or (Q)uit:  192.168.1.254 

5. DNS server 1 

Select one function (1-9,A,R,Q):  5 
----------------------------------------- 
[DNS server 1] 
Input new DNS server 1 address or (Q)uit:  192.168.1.254 

6. DNS server 2 

Select one function (1-9,A,R,Q):  6 
----------------------------------------- 
[DNS server 2] 
Input new DNS server 2 address or (Q)uit:  192.168.1.254 

A. Apply New Network Settings: 

Select one function (1-9,A,R,Q): a 

R. Refresh Status 
 * Please select (A)"Apply New Network Settings" after changed your settings. 

Select one function (1-9,A,R,Q):  r 

----------------------------------------- 

********    W A R N I N G    ******** 

[Network Status Refresh] 

Settings have been changed and haven't been apply to device. 

It will LOSE the settings you just changed after refresh 

Are your sure to REFRESH (y/n)  : 

7. IP Address Report to IP: 

Select one function (1-9,A,R,Q):  7 

----------------------------------------- 

[set Auto report IP] 

Input new IP address device auto report to or (Q)uit:  192.168.1.30 
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8. To TCP port            Set "To IP" first 

Select one function (1-9,A,R,Q):  7 
----------------------------------------- 
[set Auto report IP] 
Input new IP address device auto report to or (Q)uit:  192.168.1.30 
----------------------------------------- 
<Network Setting> 
 1. IP configuration       Static 
 2. IP address             192.168.1.77 
 3. Netmask                255.255.255.0 
 4. Gateway                192.168.1.254 
 5. DNS server 1           192.168.1.254 
 6. DNS server 2 
 A. Apply New Network Settings 
 R. Refresh Status 
 * Please select (A)"Apply New Network Settings" 
   after changed your settings 
<IP Address report> 
 7. To IP                  192.168.1.30 
 8. To TCP port            0 
 9. Period(sec)            0(Zero second means Disable) 
Q. Exit 
 
Select one function (1-9,A,R,Q):  8 
----------------------------------------- 
[set Auto report IP TCP port] 
Input new Auto report to TCP port or (Q)uit: 
 

 9. Period(sec)            Set "To IP" first 

Select one function (1-9,A,R,Q):  9 
----------------------------------------- 
[set Auto report IP period] 
Input new Auto report IP period(in seconds) or (Q)uit: 
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4. Ports settings 
Displays the set of ports available: 
Select one function (0-9,A,C,L,S,R,Q):  4 

 

----------------------------------------- 

[Ports setting] 

1. port1 (Port1) 

2. port2 (Port2) 

3. port3 (Port3) 

4. port4 (Port4) 

Q. Exit 

 

Select port or (Q)uit: 

Select one function (0-9,A,C,L,S,R,Q):  4 
 
----------------------------------------- 
[Ports setting] 
1. port1 (Port1) 
2. port2 (Port2) 
3. port3 (Port3) 
4. port4 (Port4) 
Q. Exit 
 
Select port or (Q)uit:  2 
----------------------------------------- 
[port2(Port2) Setting] 
1. Serial Settings 
2. Operating Settings 
3. Port Notification Settings 
A. Apply Settings 
R. Refresh Port Status 
Q. Exit 
 
* Please select (A)"Apply Settings" after changed your settings 
Select one function (1-3,A,R,Q): 
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1. Serial Settings: 
* Please select (A)"Apply Settings" after changed your settings 
Select one function (1-3,A,R,Q):  1 
----------------------------------------- 
[Serial Setting] 
<port2> 
  1. Port Alias: Port2 
  2. Baudrate:   38400        6. Stop Bits:  1STOPBIT 
  3. Parity:     No Parity    7. Flow Ctrl:  No Flow 
  4. Data Bits:  8            8. Interface:  RS232 
  5. performance:  Throughput 
<Delimiter Settings> 
  <Serial to Ethernet> 
  A. Delimiter1:  Disable     B. Delimiter2:  Disable 
  C. Delimiter3:  Disable     D. Delimiter4:  Disable 
  E. Flush Serial to Ethernet Data Buffer After: 0 ms 
  <Ethernet to Serial> 
  F. Delimiter1:  Disable     G. Delimiter2:  Disable 
  H. Delimiter3:  Disable     I. Delimiter4:  Disable 
  J. Flush Ethernet to Serial Data Buffer After: 0 ms 
K. Force TX interval time: 0 ms 
Q. Exit 
 
Select one function (1-8,A-K,Q): 
 

2. Operating Settings: 
* Please select (A)"Apply Settings" after changed your settings 
Select one function (1-3,A,R,Q):  2 
----------------------------------------- 
[port2(Port2) Operating Setting] 
1. Operating Mode:   Vircom mode 
<Vircom mode> 
 2. idle Timeout :  0 sec            3. Alive check : 40 sec 
<Multilink> 
 A. Max Connections: 1 
E  Data Encryption:  Disable 
Q. Exit 
 
Select one function : 
 

3. Port Notification Settings: 
* Please select (A)"Apply Settings" after changed your settings 
Select one function (1-3,A,R,Q):  3 
----------------------------------------- 
[port2 Notification Settings] 
1. SNMP Trap setting 
2. Email Notification settings 
3. System Log setting 
Q. Exit 
 
Select one function (1-3,Q): 
 

A. Apply Settings: Use "Apply Settings" after changing your settings. 

R. Refresh Port Status: displays “Refresh succcess!” when done. 

Q. Exit: quits the session and exits the application.  
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5. Security(Accessible IP) Settings 
Displays access IP settings: 
Select one function (0-9,A,C,L,S,R,Q):  5 

 

----------------------------------------- 

[Access IP Setting] 

            IP Address        Netmask 

1.  IP-1 

2.  IP-2 

3.  IP-3 

4.  IP-4 

5.  IP-5 

6.  IP-6 

7.  IP-7 

8.  IP-8 

9.  IP-9 

10. IP-10 

11. IP-11 

12. IP-12 

13. IP-13 

14. IP-14 

15. IP-15 

16. IP-16 

Q.  Exit 

 

Select one function (1-16,Q): 

 

Select one function (1-16,Q):  1 
 
----------------------------------------- 
[Set Access IP-1] 
Input new Access IP-1 IP address or (Q)uit:  192.168.1.99 
Input new Access IP-1 netmask address:  255.255.255.5  
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6. Notification(Auto Warning) Settings 
Displays notification settings: 
Select one function (0-9,A,C,L,S,R,Q):  6 
 
----------------------------------------- 
[Notification Settings] 
1. SNMP Trap setting 
2. Email Notification settings 
3. System Log setting 
Q. Exit 
 
Select one function (1-3, Q): 

1. SNMP Trap setting 

Select one function (1-3, Q):  1 

----------------------------------------- 

[SNMP Trap settings] 

<SNMP trap server> 

 A. SNMP trap server1 address: 

 B. SNMP trap server2 address: 

 C. SNMP trap server3 address: 

 D. SNMP trap server4 address: 

<Event Type> 

 1. Cold start                      Disable 

 2. Warm start                      Disable 

 3. Authentication failure          Disable 

 4. IP address changed              Disable 

 5. Password changed                Disable 

 6. Access IP block                 Disable 

 Q. Exit 

 

Select one function (A-I,1-9,Q): 
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2. Email Notification settings 

Select one function (1-3, Q):  2 
----------------------------------------- 
[Email Notification settings] 
 <SMTP server> 
 A. Server Address : 
 B. Server Port :    0 
 <E-mail list> 
 S. E-mail list Settings 
<Event Type> 
 1. Cold start                      Disable 
 2. Warm start                      Disable 
 3. Authentication failure          Disable 
 4. IP address changed              Disable 
 5. Password changed                Disable 
 6. Access IP block                 Disable 
 Q. Exit 
 
Select one function (A,B,E-I,s,1-9,Q):  

3. System Log setting 

Select one function (1-3, Q):  3 
----------------------------------------- 
[System Log settings]<System Log server> 
 A. Server address: 
 B. Port:                      0 
<Event Type> 
 1. Cold start                      Disable 
 2. Warm start                      Disable 
 3. Authentication failure          Disable 
 4. IP address changed              Disable 
 5. Password changed                Disable 
 6. Access IP block                 Disable 
 Q. Exit 
 
Select one function (A-I,1-9,Q): 
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c. Change Password 
Displays the option to change passwords: 
Select one function (0-9,A,C,L,S,R,Q):  c 

 

----------------------------------------- 

[Change Password] 

Input old password: 

L. Load Factory Defaults 
Displays the option to load the factory default settings: 
 

Select one function (0-9,A,C,L,S,R,Q):  l 

 

----------------------------------------- 

[Load Default] 

Are you sure? (Y/N) 

S. Save configuration 
Displays the option to save the existing configuration to a file. 
Select one function (0-9,A,C,L,S,R,Q):  s 

 

----------------------------------------- 

[Save to file] 

Are you sure? (Y/N) 

R. Reboot 
Displays the option to reboot the system: 
Select one function (0-9,A,C,L,S,R,Q):  r 

 

----------------------------------------- 

[Reboot System] 

Are you sure? (Y/N) 

Q. Exit & Logout 
Displays the option to quit immediately (logout and exit the session): 
Select one function (0-9,A,C,L,S,R,Q):  e 
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4.6 Uninstall SDS Manager 
1. Exit the SDS-Manager if it is currently running. 
2. Navigate to the install location (e.g., C:\Program Files (x86)\SDS-Manager) and double click the uninstall.exe 

icon.  
3. Answer any prompts.   

Messages 
Message: Warning SDS-Manager is running. Please Close it, then do uninstall.  
Keep the virtual COM running? 

    
Meaning:  You tried to uninstall the SDS-Manager with it still running. 
Recovery:  
1. Click the OK button to clear the Warning dialog. 
2. At File > Exit select either exit and remove the virtual COM, or exit and keep the virtual COM resident. 
3. Continue with the uninstall procedure above. 
 
Message: Cannot make a visible window modal. 

 
Meaning:  You tried to uninstall the SDS-Manager with it still running. 
Recovery:  
1. Click the OK button to clear the Warning dialog. 
2. At File > Exit select either exit and remove the virtual COM, or exit and keep the virtual COM resident. 
3. Continue with the uninstall procedure above. 
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Message:  This program might not have installed correctly 
Meaning:  Windows “Program Compatibility Assistant” message.    
Recovery:  
1. Try clicking the Reinstall using recommended settings option and follow the online instructions. 
2. Click the Cancel button and locate the installer.exe icon and right-click on it to display its Properties.  
3. At the Compatibility tab, select the mode that matches your Windows version.  
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5 Technical Specifications 

Port Configuration Two 10/100Base-TX Copper  
Four DB9 RS-232/422/485 

Baud Rate 110bps to 460 Kbps 

Data Bits 7,8 

Parity Odd, Even, None, Mark, Space 

Stop Bits 1, 1.5, 2 

RS-232 TxD, RxD, RTS, CTS, DTR, DSR, DCD, RI, GND 

Flow Control XON/XOFF, RTS/CTS, DTR/DSR 

Power Options 12-48 VDC, redundant inputs 

Overload current protection Present 

Reverse polarity protection Present on terminal block 

Power Consumption 4.32 Watts 

Ingress Protection IP 30 

Operating Temperature -40°C to +70°C (+14 to +140̊F) 

Storage Temperature -40°C to +85°C (-40 to +185F̊) 

Operating Humidity 5% to 95% non-condensing 

Dimensions 66mm (W) x 81mm (D) x 95mm (H) 

Weight 0.84 lbs [0.39kg] 

Operating Modes Virtual Com / Serial Tunnel / TCP Server / TCP Client / UDP 

Security SSL data encryption + Secure management by HTTPS + SSH IP Access + IP White List 

Event Warning SYSLOG / Email / SNMP Traps 

Windows OS support Windows Server 2003 and 2008, Windows XP, Windows 7, Windows 8.  

Protocols ICMP, IP, TCP, UDP, DHCP, BOOTP, SSH, DNS, SNMP V1/V2c, HTTPS, SMTP, SSL 

Safety EN60950-1 

EMI/EMS 

FCC Part 15, CISPR22/EN55022 Class A;  
EN61000-4-2; EN61000-4-3; EN-61000-4-4;  
EN61000- 4-5; EN61000-4-6; EN61000-4-8;  
EN61000-4-11 

Environment Compliance IEC60068-2-32 (Free fall); IEC60068-2-27 (Shock); IEC60068-2-6 (Vibration) 

TBF MTBF = 796,343.1796 hours. Environment: GFC, Ground Fixed Controlled; Oper. Temp. 
25 deg. C; Category: Telcordia SR-332 Issue 2. 

Warranty 5 Years 

Note: All specifications are subject to change without notice. 
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Power Supply Specifications 
Power supply options are PN 25130 and PN 25135. Specs are provided below (subject to change). 

25130 Features and Specifications 
Features 

• Variable AC input range 
• Protected against Overload and Over Voltage 
• Convection air cooling 
• DIN rail mountable 
• UL 508 approved 
• Full load burn in test 
• RoHS Compliant 
• MTBF 301.7Khrs 

 
Specifications 
Output:  

• Output Voltage: 48VDC 
• Current Rating: 0.83A 
• Power Rating: 39.8 Watts 
• Ripple & Noise Max: 200mVp-p 
• Voltage Range: 48~56VDC 
• Voltage Tolerance: ±1.0% 
• Line Regulation: ±1.0% 
• Load Regulation: ±1.0% 
• Setup, Rise Time: 500ms, 30ms 
• Hold Up Time: 20ms/115VAC  

Input:  
• Voltage Range Switch Selectable: 88~264VAC, 120~370VDC 
• Frequency Range: 47~63Hz 
• Efficiency: 88% 
• AC Current (Typical): 1.1A@115VAC, 0.7A@230VAC 
• Inrush Current (Cold): 30A@115VAC, 60A@230VAC 
• Leakage Current: <1mA@240VAC  

Protection  
• Overload: 105~150% 
• Overvoltage: 57.6~64.8V  

Dimensions:  
• Width: 1.57” [40 mm] 
• Depth: 3.94” [100 mm] 
• Height: 3.54” [90 mm]  

Environment:  
• Operating Temp: -20°C to +70°C 
• Storage Temp: -40°C to +85°C 
• Humidity: 20% to 90% (non-condensing)  

Weight:  0.66 lbs. [0.3 kg]  
MTBF:  301.7Khrs 

Certifications:  
• Safety: UL508, TUV EN60950-1, NEC Class 2, LPS Compliant, UL60950-1, EN55011, EN55022, 
• CISPR22, EN61204-3 Class B, 
• EN61000-3-2, EN61000-3-3, EN61000-4-2, 
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• EN61000-4-3, EN61000-4-4, EN61000-4-5, 
• EN61000-4-6, EN61000-4-8, EN61000-4-11, 
• EN55024, EN61000-6-2, EN50082-2, EN61204-3 A, 
• IEC60068-2-6 (Vibration) 

Warranty: Lifetime 
 
25130 Dimensions 
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25135 Features and Specifications  
Features 

• Universal AC input range 
• Protected against Overload and Over Voltage 
• Convection air cooling 
• DIN Rail mountable 
• UL 508 approved 
• Full load burn in test 
• RoHS compliant 
• MTBF 584Khrs 
• Lifetime warranty 

Output 
Voltage: 24VDC 
Current Rating: .42A 
Power Rating: 10 Watts 
Ripple & Noise Max: 150mVp-p 
Voltage Tolerance: ±2.0% 
Line Regulation: ±1.0% 
Load Regulation: ±2.0% 
Setup, Rise Time: 1000ms, 30ms 
Hold Up Time: 25ms/115VAC 

Input  
Voltage Range: 85~264VAC, 120~370VDC 
Frequency Range: 47~63Hz 
Efficiency: 84% 
AC Current (Typical): .33A@115VAC 
.21A@230VAC 
Inrush Current (Cold): 35A@115VAC 
70A@230VAC 
Leakage Current: <1mA@240VAC 

Protection  
Overload: 105% Rated Output 
Overvoltage: 27.6~32.4V 

Dimensions  
Width: 0.89” [22.5 mm] 
Depth: 3.94” [100 mm] 
Height: 3.54” [90 mm] 

Environment  
Operating Temp: -20°C to +70°C 
Storage Temp: -40°C to +85°C 
Humidity: 20% to 90% (non-condensing) 
Weight 0.37 lbs. [0.17 kg] 
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Certifications 
Safety: UL508, TUV EN60950-1, NEC Class 2/LPS 
EMC Emissions: EN55011, EN55022, CISPR22, 
EN61204-3 Class B, EN61000-3-2, EN61000-3-3 
EMC Immunity: EN61000-4-2, EN61000-4-3, 
EN61000-4-4, EN61000-4-5, EN61000-4-6, 
EN61000-4-8, EN61000-4-11, EN55024, 
EN61000-6-1, EN61204-3 A 
IEC60068-2-6 (Vibration) 
 
25135 Dimensions 
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6 Troubleshooting 
This section lists some common problems, their causes, and potential recovery steps. Note that any unauthorized 
repairs or modifications will void the SDS warranty. 

6.1 FAQs 

Q1. What is meant by “5 x redundant hosts”? Does it mean 5 x serial port device? 
A1. “5 x redundant host” mean the maximum number of connections is 5 redundant host PCs connect via 
Ethernet to the SDS device, with 5 redundant host PCs (VCOM, TCP server, TCP client; or 4 redundant host PCs 
in UDP mode. 

Q2. Can you explain the "Auto Scan" button?  
A2. When you click the “Auto Scan” button, the system will automatically scan ports 4000 to 65535, and check 
which port is free.  For example, if port 4000 is free, the control port number will be set to 4001.   

Q3. What is the UDP mode used for?  
A3. UDP mode is different from TCP mode; UDP does not need to establish connection for data transmission.  
A UDP listening port is just for receiving data from the network. If you send data to a UDP listening port, it is used 
for receiving. If you want to send data to a destination host, you can write data to the serial port, and the data will 
be sent to the destination host and port.   

Q4. What is the "Disconnect" button used for?  
A4. The Disconnect button lets you manually disconnect the TCP client connection from the TCP Server. 

Q5. On initial install I get an “unsigned driver” message. What does it mean and is it OK to proceed? 
A5. When you connect a new hardware device to your computer, Windows tries to find and install a software 
driver for the device. You may see a notification that a driver is unsigned.  
► Windows will alert you with a message if a driver is unsigned, was signed by a publisher that hasn't verified its 
identity with a certification authority, or has been altered since it was signed and released. For example, the 
message Windows requires a digitally signed driver displays if a driver lacks a valid digital signature, or was 
altered after it was signed, can't be installed on 64-bit Windows.  
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6.2 Procedure  

If the SDS device fails, isolate and correct the failure by performing the following steps. 

1. If the SDS does not turn on and no LEDs light, then the SDS or the power source may be damaged, or the 
SDS does not have power. Make sure that the power source is properly connected to the SDS. Make sure the 
power adapter is connected to a functioning electrical outlet. 

2. Verify the steps in section 3.4 Wiring on page 16.  Verify the steps in section 3.5 Connection on page 17.   
See section 2.1.3  LED Descriptions on page 11 for LED descriptions.  

3. If the SDS does not respond even though it is functioning. Verify that the SDS is powered up; the serial cable is 
correct and undamaged, and that the serial port settings are correct. Verify the cable pinouts, try a different serial 
cable, and then try a different port on the SDS.  

4. Check recent notifications. See Notification tab on page 27 or 4.2.5  on page 43.  

5. If the SDS is not discovered, verify that the PWR LED is lit. If the Status LED is not lit, check the firmware 
version. If the SDS firmware has been upgraded from the factory default, reset the SDS to its factory defaults.  
Cycle power on the box and wait approximately 30 seconds. Verify that the SDS and the PC are on same subnet.  

6. If the Web browser does not display, check the Web connection. Verify that a supported browser being used. If 
not, install and use a supported browser. Use Ping to verify the connection. If ping fails, verify that the subnet 
mask, Gateway address, and IP address are OK. Correct the PC setup and then retry. If ping is OK, check if IE is 
set up to use a proxy server. If so, disable the proxy server and retry.  

7. Make sure that the application is set to use the correct COM port number. Verify that the COM port(s) shows up 
in the PC’s Device Manager. 

8. If you are having problems with changing the serial interface settings: 
With a VCOM set up to a serial port, and a DB9 cable connected to a serial device, changing the interface type 
(e.g., from RS232 to RS422) will hang the SDS unit. The unit can be pinged but will not connect to the SDS-
Manager or the web. The SDS unit must be power reset to restore the connection. This occurs if the change is 
made from the SDS-Manager or the Web UI. This applies to both the SDSTX 3110-121-LRT-B and SDSTX3110-
124-LRT-B. 
Once a VCOM connection has been set up, do not make serial port changes.  
For reference, once you have a VCOM set up to a serial port, a DB9 cable connected to a serial device and an 
application running over the VCOM connection, changes to the serial settings are blocked by the software. 
After a Virtual COM has been mapped to a port, changes to the serial settings of that port (e.g., from RS232 to 
RS422) should not be made. 

9. Check the website for updated firmware; upgrade if available. See Upgrade Firmware tab on page 30.  

10. Record model information (see below) and then contact Tech Support. 
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6.3 Record Model and System Information 
After performing the troubleshooting procedures, and before calling or emailing Technical Support, please record 
as much information as possible to help the Technical Support Specialist. 

1. Record the Model Information for your system. See Package and Device Labeling below.  

Serial Number: ________________________ Model Number:  ________________________________ 

Software Revision: _____________________ Hardware Revision: ______________________________ 

2. Record the System Configuration information for your system. 

Console Access: ________________________  Number of Ports: ______________________ __________ 

MAC Address: __________________________ IP Address: _____________________ ________________ 

3. Provide additional product information to your Technical Support Specialist.  

Your Lantronix service contract number: ____________________________________________ 

Describe the failure: _____________________________________________________________________ 

______________________________________________________________________________________ 

Describe any action(s) already taken to resolve the problem (e.g., change switch mode, reboot, etc.): 
______________________________________________________________________________________ 

______________________________________________________________________________________ 

The serial # and revision # of each involved Lantronix product in the network: 
_____________________________________________________________________________________ 

_____________________________________________________________________________________ 

4. Describe your network environment (layout, cable type, etc.): ___________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

Network load and frame size at the time of trouble (if known): ___________________________________ 

The device history (i.e., have you returned the device before, is this a recurring problem, etc.): 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

5. Any previous Return Material Authorization (RMA) numbers: ____________________________________ 

______________________________________________________________________________________ 
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6.4 Package and Device Labeling 

Record information from the SDS package label and device S/N label: 
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7  Safety and Compliance Information 

7.1 Compliance Information 

FCC Regulations  
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, 
may cause harmful interference to radio communications. Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be required to correct the interference at his own 
expense. 

Canadian ICES-003 
This Class A digital apparatus complies with Canadian ICES-003. 
Cet appareil numériqué de la classe A est conformé à la norme NMB-003 du Canada. 

CE Marking 
This is a Class A product. In a domestic environment, this product could cause radio interference; as a result, the 
customer may be required to take adequate preventative measures.  

UL Listed Power Supply 
The Power Supply is tested and recognized by the Underwriters Laboratories, Inc.  

EU Declaration of Conformity 
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European Regulations 

WARNING: This is a Class A product. In a domestic environment, this product could cause radio interference in 
which case the user may be required to take adequate measures. 

Achtung !  Dieses ist ein Gerät der Funkstörgrenzwertklasse A. In Wohnbereichen können bei Betrieb dieses 
Gerätes Rundfunkstörungen auftreten.  In diesem Fäll ist der Benutzer für Gegenmaßnahmen verantwortlich. 

Attention !  Ceci est un produit de Classe A.  Dans un environment domestique, ce produit risque de créer des 
interférences radioélectriques, il appartiendra alors à l’utilsateur de prende les measures spécifiques 

appropriées. 

 In accordance with European Union Directive 2002/96/EC of the European Parliament and of the 
Council of 27 January 2003, Lantronix will accept post usage returns of this product for proper 
disposal. The contact information for this activity can be found in the ‘Contact Us’ portion of this 
document. 

 CAUTION: RJ connectors are NOT INTENDED FOR CONNECTION TO THE PUBLIC TELEPHONE NETWORK. Failure 
to observe this caution could result in damage to the public telephone network. 

 
Der Anschluss dieses Gerätes an ein öffentlickes Telekommunikationsnetz in den EG-Mitgliedstaaten 

verstösst gegen die jeweligen einzelstaatlichen Gesetze zur Anwendung der Richtlinie 91/263/EWG zur 
Angleichung der Rechtsvorschriften der Mitgliedstaaten über Telekommunikationsendeinrichtungen 
einschliesslich der gegenseitigen Anerkennung ihrer Konformität.* 

7.2 Safety Warnings and Cautions 
These products are not intended for use in life support products where failure of a product could reasonably be 
expected to result in death or personal injury. Anyone using this product in such an application without express 
written consent of an officer of Lantronix does so at their own risk and agrees to fully indemnify Lantronix for 
any damages that may result from such use or sale. 

 

 Attention: this product, like all electronic products, uses semiconductors that can be damaged by 
ESD (electrostatic discharge). Always observe appropriate precautions when handling. 

  Warning: Potential for damage to equipment or personal injury.  

 Warning: Risk of Electrical Shock 

  Functional grounding point  

 Protective grounding point 

 Special considerations 
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7.3 Electrical Safety Warnings 

Electrical Safety 
IMPORTANT: This equipment must be installed in accordance with safety precautions. 

Elektrische Sicherheit 
WICHTIG: Für die Installation dieses Gerätes ist die Einhaltung von Sicherheitsvorkehrungen erforderlich. 

Elektrisk sikkerhed 
VIGTIGT: Dette udstyr skal 93nstallers I overensstemmelse med sikkerhedsadvarslerne. 

Elektrische veiligheid 
BELANGRIJK: Dit apparaat moet in overeenstemming met de veiligheidsvoorschriften worden geïnstalleerd. 

Sécurité électrique 
IMPORTANT : Cet équipement doit être utilisé conformément aux instructions de sécurité. 

Sähköturvallisuus 
TÄRKEÄÄ : Tämä laite on asennettava turvaohjeiden mukaisesti. 

Sicurezza elettrica 
IMPORTANTE: questa apparecchiatura deve essere installata rispettando le norme di sicurezza. 

Elektrisk sikkerhet 
VIKTIG: Dette utstyret skal 93nstallers I samsvar med sikkerhetsregler. 

Segurança eléctrica 
IMPORTANTE: Este equipamento tem que ser instalado segundo as medidas de precaução de segurança. 

Seguridad eléctrica 
IMPORTANTE: La instalación de este equipo deberá llevarse a cabo cumpliendo con las precauciones de 
seguridad. 

Elsäkerhet 
OBS! Alla nödvändiga försiktighetsåtgärder måste vidtas när denna utrustning används.  

 

7.4 Encryption Registration Number 
ERN # (Encryption Registration Number) R111839   
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Lantronix Corporate Headquarters 
7535 Irvine Center Drive 
Suite100 
Irvine, CA 92618, USA 
Toll Free: 800-526-8766 
Phone: 949-453-3990 
Fax: 949-453-3995 

Technical Support 
Online: http://www.transition.com/support.  

Sales Offices 
For a current list of our domestic and international sales offices, go to the Lantronix web site at 
www.lantronix.com/about/contact.  

https://www.lantronix.com/
http://www.transition.com/support
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